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Windows 10 Setup Tips & Resources 
I n f o r m a t i o n  T e c h n o l o g y  S e r v i c e s  

Revised June 24, 2020 

FIRST-TIME LOGIN 
If possible, use a wired Ethernet connection for this process. If you do not have access a wired 
connection a Wi-Fi connection that requires only a password to connect to it will also work. 

For more details on this process, visit http://go/setup/ and see the “Windows User Guide for Zero 
Touch Deployments” page. 

1. Unbox and plug your computer into a wall power outlet. Connect directly to your network via an 
ethernet cable if possible and power on the computer. 

2. Choose the region. This defaults to the United States, so you can simply press "enter" or click "Yes". 
3. Choose your keyboard layout. This defaults to a US keyboard, so you can simply press "enter" or click 

"Yes". 
4. Unless needed, skip adding a second keyboard layout. 
5. Connect to your network via a hard-wired connection or Wi-Fi. A hard-wired ethernet connection is best, 

but you are welcome to connect via Wi-Fi if that is the only internet connection available. 
6. Once connected, confirm you want to allow network discovery (click yes). 
7. Click “Next” after the connection is complete. 
8. The computer will reboot. 
9. Enter your Middlebury email address (complete with “@middlebury.edu”). This setup phase links your 

computer to Middlebury resources and makes you a local administrator. 
10. Enter your Middlebury password. 
11. Complete the MFA (multi-factor authentication) process. 
12. Your computer will now automatically install settings from Middlebury. This can take between 5-25 

minutes depending on your internet speeds. The computer will reboot once or twice during this phase 
while it installs essential apps like Antivirus and OneDrive. 

13. Login, allow initial account setup to complete, and complete the MFA prompt a second time. 
14. It will now show the setup screen again while it installs user specific applications and settings. You may 

click “Continue anyway” to go straight to the desktop while this happens. 
15. You are now logged in and ready to access Middlebury apps and other resources. You may install your 

preferred browser and other apps now. 

16. To access the “Company Portal” for many Middlebury provided apps, go to the Start menu  and click 

on “Company Portal” . You can also search in the taskbar search field. 
17. Here you can install apps like Microsoft Office, Pulse VPN, and Jabber. 

http://go/setup/
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IMPORTANT BASICS:  Shut Down, Restart & Sign Out 
The most important things you need to know about your new computer are how to shut it down and 
how to sign out as these processes are different in Windows 10: 

• To SHUT DOWN, RESTART, or put the computer to SLEEP:  Click   (Start) then  (Power). 

• To SIGN OUT (formerly Log off):  Click   then your account icon , then Sign out. 

SELF SERVICE SOFTWARE INSTALLATION 
ITS does not install software titles that are available to you via self-service methods.  Here are the 
installation websites you can visit at your convenience to obtain commonly requested programs: 

• Your new computer has the Company Portal application installed on it. This is where you can find 
an always evolving selection of programs to install whenever you need them! To access the 

Company Portal, click the Start icon  and search for “Company Portal” , and then hit 
Enter. The Company Portal will open and then you can simply look for the program you want to 
install, click the program you are looking for, and click “Install” button. 

• If the software that you are looking for is not in the Company Portal, please see our Service 
Catalog for both Core Business Software and Academic Software to see how the software can be 
obtained. Both can be found using the links below. 

o Core Business Software Catalog: https://servicecatalog.middlebury.edu/tool-suite/core-business-
software 

o Academic Software Catalog: https://servicecatalog.middlebury.edu/tool-suite/academic-software 
• For Adobe products, visit http://go/adobelogin/. 

For more information, visit http://go/selfservice/. 

OUTLOOK 
Set up your Exchange Account in Outlook 

1. Click the Search Windows icon    at left on the Task Bar, then type “Outlook”. 

2. From the search results list, click Outlook Desktop app. 

3. At the Outlook dialog box, verify your email address then click Connect. 

4. At the Middlebury-branded login screen, provide your account password then click Sign In. 

5. Click Yes to “Allow my organization to manage my device.” 

6. When the You’re all set! message appears, click Done. 

7. Account successfully added should appear for your Office 365 account. 

a. DO NOT use the “add another email address” to add other Middlebury mailboxes! 
b. You may wish to UNcheck the box beside “Set up Outlook Mobile on my phone, too.” 
c. Click DONE. 

8. When “Sign in to set up Office” appears, click Sign in. 

9. The Activate Office dialog appears. Supply your email address, then click Next. 

https://servicecatalog.middlebury.edu/tool-suite/core-business-software
https://servicecatalog.middlebury.edu/tool-suite/core-business-software
https://servicecatalog.middlebury.edu/tool-suite/academic-software
http://go/adobelogin/
http://go.middlebury.edu/selfservice/
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10. Take a moment to “pin” Outlook by right-clicking its icon on the Taskbar, then choosing Pin to 
taskbar. 

11. Be patient while Outlook prepares for first-time use.  When your email retrieval from the cloud 
has completed, All folders are up to date displays in the status area at the bottom of the Outlook 
window. 

 NOTE:  It is OK to proceed with adding Midd mailboxes before your email retrieval has completed. 

Add More Middlebury Mailboxes 
If you work with other Middlebury email accounts apart from your own, such as FAX accounts, you need 
to make a few adjustments so everything will work smoothly.  You may also need to add additional 
accounts if they do not appear in Outlook’s left-hand navigation pane on their own.  Here’s what to do: 

1. With Outlook running, click the File tab; Info is already selected. 

2. Click , then choose Account Settings… from the drop-down menu. 

3. Double-click on your email address in the Name column.  The Change Account dialog box opens. 

4. Click .  The Microsoft Exchange dialog box opens. 

5. Click the Advanced tab. 

6. Uncheck the box beside Download shared folders to shut off cached mode for the other 
accounts.  Doing this prevents viewing issues (such as missing folders or meetings) when using 
shared accounts. 

7. To add email accounts that have not appeared in your navigation pane, click .  The 
Add Mailbox dialog box opens. 

8. In the Add mailbox field type part of the display name for the mailbox you want to add and then 

click .  The mailbox name appears on the Open these additional mailboxes list. 

9. Click .  A notice appears about the need to restart Outlook.  Click  as 
needed to return to the Change Account dialog window. 

10. From the Change Account dialog box, click .  When Account successfully updated 
appears, click DONE. 

11. Close the Account Settings dialog box. 

Common Outlook Setting Adjustments 
• If you don’t care for the reading pane, click the View tab, then click the Reading Pane button.  Select 

Off from the drop-down list. 
• Wonder where the From and Bcc fields went?  Start a new message then click the Options tab.  Now 

click the Bcc and From buttons on the ribbon.  These fields will now appear when creating future 
messages. 
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• Did you save any Outlook views from your old computer?  To reapply them, click the View tab, then 
click the Change View button (far left).  Your named views will be available for use. 

Restore Signatures 
If you only use a few signatures, you can easily recreate them.  Here’s how: 

1. Open an old message from your Sent Items folder, then copy your signature text. 
2. Click File / Options, then click Mail. 
3. Click the Signatures button. 
4. Click the New button, give your signature a name, paste in your information, adjust default 

signature choices at right, then click OK. 

If you had multiple signatures and saved them from your old computer, here’s how to put them where 
they need to go: 

1. Open the folder where you saved your signature files then use CTRL+A to select them all. 
2. Right-click any selected file, then choose Copy. 
3. Launch Outlook, then click File / Options, then Mail. 
4. Hold down the CTRL key when you click the Signatures button.  This opens the empty folder 

where the signatures files need to go. 
5. Right-click in the right-hand pane, then choose Paste.  Your individual signature files are now 

ready for use. 
6. Close the Signatures window. 
7. Click the Signatures button again so you can specify your defaults, then click OK to save your 

changes. 

CLOUD STORAGE 
OneDrive Setup 
Microsoft’s OneDrive app is included in the installation of Office 365; you just need to set it up as 
follows: 

1. Use the Search Windows icon    on the Task Bar to look up, then launch the OneDrive app. 
2. Provide your email address when prompted, then click Sign in. 
3. Provide your Middlebury username and password if prompted, then click Next to accept the 

default OneDrive folder location on your hard drive. 
4. In the Sync your OneDrive files to this PC window, adjust your sync settings as desired, then click 

Next.  Folders and files that you choose to download to the computer will be available to you 
even when your computer is offline but they will take up space on your computer. 

5. The local OneDrive – Middlebury College folder is created on your computer, and the files and 
folders you specified to sync will begin to appear as they are copied down from the cloud. 

NOTE:  You may adjust syncing and app settings at any time; just click the blue cloud icon on the far 
right of your TaskBar.  You may wish to turn on Files On-Demand to save storage space on your 
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computer.  These items are available only when you have an internet connection unless you specify 
otherwise.  Click the cloud, choose More, then Settings, then click the Settings tab to reach where this is 
found. For more information about OneDrive use, visit http://go/onedrivehelp/. 

Google’s Drive File Stream Setup 
If you prefer to use Google’s Drive File Stream to synchronize files between your computer and the 
cloud, you will need to download and install the application.  Important:  If you only work with Google 
files via a web browser then you need not install this software! 

To install the application: 

1. Visit http://go/getgdfs/, then click the blue Sign in button at top right.  Provide your Middlebury 
email address and password. 

2. Expand the Download & Install Drive File Stream section, then click the Download for Windows 
button.  Save then and run the installer. 

Note:  By default, Drive Stream Files are stored in the cloud and are available for use only when you are 
connected to the internet.  Specific folders can be designated for off-line use. 
For more information about Google apps, visit http://go/gdrivehelp/. 

MAKING CONNECTIONS 
Connect to Middlebury using VPN – Pulse Secure 

  Pulse Secure software used for VPN is available through the Company Portal application on your 
new computer; you just need to specify the server (https://vpn.middlebury.edu ) and save your 
connection details with a name for future use.  Need more details?  Visit http://go/vpn/ and start with 
step 4 of the Windows section. 

Access to use the VPN needs to be requested. If you were able to connect to it on your previous 
computer, you should still be able to connect to it on your new device. If you have problems connecting 
to the VPN, please reach out to the Service Desk and include any errors you may be getting. 

Connect to a Projector 
Follow the directions to connect your laptop in a Smart Classroom.  (Refer to http://go/smartguides/ for 
helpful info.) 

Click the Windows 10 Action Center icon (  at far right), choose Project, then select how your 

display should appear.   +  can still be used as a shortcut to call up the projection options. 

http://go.middlebury.edu/onedrivehelp
http://go.middlebury.edu/getgdfs
http://go.middlebury.edu/gdrivehelp
http://go/vpn/
http://go/smartguides/
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PRINTERS & MONITORS 
Add Printers 

Network printers have labels showing their Printer Queue Name.  You will need this information before 
you can install the printer on your computer. If you are trying to add a network printer while you are off 
campus, you will need to first connect to the VPN. 

1. Press the Windows key ( ), type \\walnut, then press the Enter key. 
2. Click in the Search Walnut field at top right, then type a few initial characters of your printer 

name (such as OCH, MNR, BIH, or P01).  Results will be filtered for you. 
3. Right-click the desired printer then select Connect from the drop-down menu. 
4. Click the Install driver button if prompted. 
5. Repeat steps 2 -4 as needed to install additional printers. 

Set Your Default Printer 
If you have added more than one printer you should specify the one you’ll use most often, otherwise 
Windows 10 will set the default printer to the one used most recently at your current location. 

1. Click   then click   (Settings). 

2. Click . 

3. Click Printers and Scanners at left. 
4. Uncheck the box beside Let Windows Manage my default printer to turn off this feature. 
5. Click the desired printer’s name in the Printers & scanners list, then click the Manage button. 

Click the Set as Default button, then close the Settings window. 

WEB BROWSER FAVORITES (Bookmarks) 

Restore your Mozilla Firefox Favorites (Bookmarks):  

If you set up a Sync account on your old computer… 

1. Launch Firefox.  When prompted, enter the email address and password you used to set up 

syncing, then click Continue.  (If not prompted, click the menu icon  in upper right, then 
choose “sign in to sync.”) 

2. Provide the password you created earlier for your Firefox account. 
3. An email message is sent to confirm your request.  Note that this message may end up in your 

Junk Email folder. 
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4. Once your new computer is connected, your desired data will begin syncing.  You may need to 
turn on the Bookmarks Toolbar by right-clicking the blank area to the right of the tabs. 

Restore your Google Chrome Bookmarks 

If you turned on Google Chrome syncing on your old computer…  You just need to sign on to Chrome 
on the new computer then turn syncing on.  See http://go/syncchrome/ for details. 

Restore your Internet Explorer Favorites (Bookmarks) 

Internet Explorer is an outdated, insecure browser.  Applications that require its use (such as Hyperion, 
Content 7, and Famis ) should be accessed via Remote Desktop Services (http://go/rds/) to safeguard 
your computer.  If you exported Internet Explorer favorites from your old computer to a file, these can 
be imported into other browsers for use. 

APPLICATIONS (aka Apps or Programs) 
Add Apps to your Taskbar or Start menu 

Pinned apps appear in the location you specify (Taskbar or the tiled area of the Start Menu) each time 
you start your computer.  You can drag pinned entries on the Taskbar to reflect the order you prefer. 

1. Click  ; the Start Menu opens showing a list of all apps, as well as a new tiled area at right. 

2. Scroll through the list and right-click frequently used apps, such as Word, then select More, then 
Pin to Taskbar (or Pin to Start – the tiled area) for ease of future access. 

 You can also search for apps by name using the Search Windows icon     on the Task 
Bar. 

3. Repeat step 2 as needed for other desired apps. 

 Note the transformation of the Start Menu into two parts.  A list of all programs appears on the left 
and customizable groupings of tiles appear on the right.  The tiling feature is geared toward touch 
screen use.   You can unpin any (or all!) tiles if you prefer a cleaner look. 

 TIP:  You may further customize your experience.  Simply right-click the Taskbar, then choose 
Taskbar settings from the pop-up menu.  Both Taskbar and Start are good places to review. 

Remove Apps from your Taskbar 
We recommend removing – UNpinning – some of the less helpful Windows 10 Taskbar apps to give you 
more room for things you want. 

 You may wish to unpin the following icons from your Task Bar:   .  These are shortcuts to 
the Microsoft Store and the Windows Mail app (not Outlook). 

http://go.middlebury.edu/syncchrome/
http://go.middlebury.edu/rds/
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Set Default Apps 

1. Click   then click   (Settings). 

2. Click  

3. Click  at left. 

4. Change the following defaults as follows: 

a. Email from Windows Mail to Outlook 

b. Web browser from Microsoft Edge to your choice. 

 

COMPUTER SETTINGS 
Adjust Power Options 
You may feel that your computer goes to sleep too often or that your monitor shuts down too 
frequently.  Here’s how to find the power settings so you can adjust them to suit your needs: 

1. Click   then click   (Settings). 
2. Type Power in the Find a setting field at left; search results will appear as you type. 
3. Choose Power & sleep settings. 
4. Adjust screen and sleep settings as desired. 

• Important:  If you have a port replicator (aka docking station), be sure to review Additional 
power settings under Related settings so you can choose what happens when you close your 
computer’s lid. 

Adjust Display Size of Text, Apps, & Other Items 
New, high-resolution displays bring greater clarity to small objects but you may wish to adjust the size of 
how things appear on your new computer all the same.  Here’s how: 

1. Click   then click   (Settings). 
2. Click System. 
3. Click Display in the left-hand navigation list. 
4. Under Scale and layout, use the drop-down menu below Change the size of text, apps, and other 

items.  You may need to sign out then back in to see the full effect of your changes. 

Make Your Scroll Bars Visible 
Do the “hide-and-seek” scroll bars try your patience?  Search for “scroll bars” then choose Automatically 
hide scroll bars in Windows from the search results.  Just click the radio button to turn off this feature. 
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Setup Dual Monitors 
If you use two monitors, you may want to adjust settings to achieve your desired set up.  Here’s how:  

1. Right-click your desktop, then choose Graphics Properties.   
2. Click Display, then choose Multiple Displays from the menu at left.  Adjust settings as desired. 

FILE MANAGEMENT 
File Explorer (formerly Windows Explorer) – Easier File Management 
Important Note:  We strongly recommend that you store work-related items on the cloud (OneDrive or 
Google Drive File Stream) or in shared departmental folders on Middfiles. 

Windows Explorer got a facelift and a new name, appearing in Windows 10 as File Explorer.  Along with 
a more logical name, you’ll enjoy its improved views and helpful toolbars that simplify common file 
management tasks.   

• Click    [File 
Explorer] on the Task 
Bar. 

• Press  +  . 

HANDY TIP: 

You can change File 
Explorer’s initial view.  
Click File, then Change 
folder and search 
options.  On the General 
tab, you can adjust the 
value for Open File 
Explorer to This PC. 

 
 

New in File Explorer… 

 File drop-down menu 
 Former “Favorites” area now called Quick access.  (See circled item above, left.) 
 New view shortcut buttons in lower right for list and large thumbnail views.  (See circled icons in 

File Explorer screen shot above.) 
 Home, Share, & View tabs with associated ribbons The View ribbon is shown here: 
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Adding Items to Quick Access 

Here’s how to create locations that will be visible in all your Microsoft programs: 

1. Open File Explorer, then navigate to and open one of your frequently used folders. 

2. Right-click  in the top left. 
3. Choose Pin current folder to Quick Access. 

HANDY TIP:  To create Middfiles favorites to shared department folders that always work – even from 
home using VPN or when using the Middlebury College wireless network -- start out by typing 
\\middcloud in File Explorer’s path field at the top.  Now, double-click to open middfiles, then continue 
navigating until you’ve opened the desired folder.  Lastly, follow steps 2 & 3 to make the “enduring” 
shortcuts. 

USING HYPERION, CONTENT 7, FAMIS & MORE – New Method 
Remote Desktop Services (aka RDS) provides a way to use applications and web pages unsupported by 
Windows 10, or that present security risks due to outdated or unsafe software requirements.  You must 
now use RDS on your Windows 10 computer to run the following programs:  Hyperion Studio, 
Perceptive Content (aka Content 7), Hyperion IRC, and Famis.  You can easily access what you need by 
bookmarking http://go/rds/ on your favored web browser. 

If you prefer individual shortcuts to specific products, refer to http://go/rdswin10/ for detailed 
instructions.  For printer-friendly instructions, look for the link to Win 10 RDS Setup in Brief. 

 

THINGS THAT ARE DIFFERENT 
 New Sophos Endpoint Protection software with full disk encryption is now in place. 

  New look for the Start icon.  Start Menu now has customizable tiles and groupings. 

 Windows Explorer renamed and redesigned – now called File Explorer. 

  New Task View supports multiple desktops so you can group related work. 

   New Action Center centralizes alerts and notices. 

http://go/rds/
http://go.middlebury.edu/rdswin10
https://mediawiki.middlebury.edu/LIS/Remote_Desktop_Services_Setup_in_Brief
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 The Show Desktop strip that used to be at the far right of the Task Bar appears to be gone, but 
you can still click there to minimize open apps and display your Desktop.  The hover feature that 
previewed the Desktop is still available with Windows 10, just right-click that area then choose 
Peek at desktop.  

Action Center 

  You’ll find this new icon at the far right of your Task Bar.  The Action Center centralizes alerts and 
notices.  See the recommended video found at http://go/win10/ to learn about this new feature and 
how you can customize it.  Many people prefer to tone down the notifications. 

Task View 

  This new icon is located on the left of your Task bar.  Task View supports multiple desktops so 
you can group related work.  See the recommended video found at http://go/win10/ to learn how to 
use this new feature. 

LEARN ABOUT WINDOWS 10 AND Office 365 

We’ve done the work for you and gathered some great ways to learn about Windows 10 and Office 365. 

⇒ Explore these “go” shortcuts using your favorite web browser: 

• http://go/win10/ – Collected learning resources to refresh or expand your Windows 10 
knowledge.  Be sure to check out the Recommended Viewing section – five videos share the 
most important features of Windows 10 in under thirty minutes!  It’s time well spent. 

• http://go/Office365help/ (or http://O365help/)– General information, collected links to 
movies and short courses covering select usage and features of Office 365 products. 

 

 

 

Be sure to check out the support information on the back page! 

 

 

http://go.middlebury.edu/win10/
http://go.middlebury.edu/win10/
http://go.middlebury.edu/win10
http://go.middlebury.edu/office365help
http://go.middlebury.edu/o365help
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Support Information 

Middlebury, VT 
• Submit a request for help (or update/review the status of your issue) using our Web Help Desk 

system, found at http://go/whd/ 
• Call us at (802) 443-2200 
• E-mail us at helpdesk@middlebury.edu 
• Connect to us via Zoom using https://middlebury.zoom.us/j/8024432200 
• Hours:  Monday - Friday, 8:30 am - 8:00 pm ET; no weekend hours 

Monterey, CA 
• Submit a request for help (or update/review the status of your issue) using our Web Help Desk 

system, found at http://go/whd/ 
• Call us at (831) 647-6656 
• Hours:  Monday - Friday, 5:30 am - 5:00 pm PT; no weekend hours 

 

 

http://go/whd/
tel:+18024432200
mailto:helpdesk@middlebury.edu
https://middlebury.zoom.us/j/8024432200?pwd=K2RWTnd0TVhDc0ZtUHZQcXFZUElzdz09
http://go/whd/
tel:+18316476656
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